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BAB IV  

HASIL DAN PEMBAHASAN  

 

IV.1. Tampilan Hasil 

 Adapun hasil dari perancangan program pada proyek game mencari 

perbedaan rumah sebagai berikut : 

IV.1.1. Halaman Game 

 Perancangan program pada halaman game pada game mencari perbedaan 

rumah memiliki beberapa tombol yang dipergunakan untuk menjalankan program 

tersebut diantaranya : 

1. Tombol mulai      : Untuk memulai permainan. 

2. Tombol Petunjuk   :  Memberikan aba- aba untuk mencari perbedaan. 

3. Tombol Berhenti   :  Jika ingin berhenti bermain game. 

4. Tombol Musik   : Dalam memainkan game ini dibuat musik supaya 

pengguna game tidak jenuh memainkannya. 

5. Tombol Pause       : Melakukan berhenti sejenak dan untuk melanjutkan 

kembali klik tombol lanjut. 

Adapun tampilan halaman game level 1 mencari 5 perbedaan rumah 

dengan waktu 3 menit dapat dilihat pada gambar IV.1 berikut : 
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Gambar IV.1. Halaman Game Level 1. 

 Adapun tampilan halaman game level 2 mencari 10 perbedaan rumah 

dapat dilihat pada gambar IV.2 berikut :  

 

Gambar IV.2. Halaman Game Level 2. 

 Adapun tampilan halaman game level 3 mencari 15 perbedaan rumah 

dapat dilihat pada gambar IV.3 berikut :  
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Gambar IV.3. Halaman Game Level 3. 

 Pada halaman game dibuat dari rectangle kemudian di shape dan 

digabungkan dengan objek gambar yang memiliki baground berwarna abu- abu 

berbola dengan line tool biru, latar background biru langit. Desain dibuat 

menggunakan Software CorelDraw X4. Dalam halaman game terdapat objek 

rumah, judul dan latar belakang yang masing- masing diletakkan didalam layer 

yang berbeda. 

 Dalam layer 1 frame 1 pada scene level 1 berikan nama layer dengan nama 

Backgroun 1 untuk menempatkan objek rumah pada latar berwarna silver, buat 

kembali layer baru dengan cara klik new layer pada Timeline dan berikan dengan 

nama layer Background2, lakukan hal yang sama pada pembuatan layer 

berikutnya untuk Background3. Lakukan Import to stage pada tiap layer untuk 

menempatkan objek yang akan dijadikan latar dalam halaman game dengan cara 

klik File>import>import to stage. Tambahkan layer baru untuk digunakan 

sebagai penampung label frame. Di panel Timeline buatlah layer baru dan berikan 

nama layer yaitu label.  
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Berikut label untuk frame dan layer label sebagai berikut :  

1. Frame 1  : frame_level 1. 

2. Frame 2  : frame_menang 1. 

3. Frame 3  : frame_kalah 1. 

Lakukan hal yang sama untuk level berikutnya, dan rubah instance name masing- 

masing sesuai dengan level. Kemudian penulis akan mengatur ulang ukuran pada 

Background1 dengan width 1500 dan height 1000, pada Background3 dengan 

width 557,05 dan height 369,20. 

IV.1.2. Pencatat Waktu Dalam Hitungan Mundur 

Adapun tampilan tombol pencatat waktu dalam hitungan mundur dapat 

dilihat pada gambar IV.4 berikut :  

 

 

Gambar IV.4. Pencatat Waktu 

1. Di panel Timeline buatlah layer baru dan berikan dengan nama label 

waktu. 

2. Buatlah dua buah kotak dynamic text dan berikan nama variabel 

tampil_menit pada kotak sebelah kiri dan nama variabel tampil_detik pada 

kotak sebelah kanan. 

3. Seleksi kedua kotak tersebut kemudian klik menu modify>convert to 

symbol berikan nama mc_waktu lalu pilih movie clip pada kolom type 

kemudian OK. 

00 : 00 
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4. Klik double pada mc_waktu untuk mengedit dalam memperpanjang 

jumlah frame, klik kanan frame 12 pilih insert frame. 

5. Berikan nama instance name waktu pada panel properties. 

Selanjutnya penulis akan mengesit Action frame agar objek dapat 

berfungsi dengan baik. Di panel Timeline pilih frame 1 pada layer waktu 

kemudian pilih mc_waktu sehingga tampil pada properties menjadi Action- Movie 

clip. 

IV.1.3. Cursor Mouse 

Di panel Timeline buat layer baru dengan nama mouse. Lakukan import 

pada objek mouse yang akan diambil dan jadikan sebagai movie clip, lakukan edit 

dan pilih frame 2 klik insert Keyframe ganti objek mouse dengan objek yang telah 

di edit. Adapun gambar cursor mouse tersebut dapat dilihat pada gambar IV.5 

dibawah ini : 

 

Gambar IV.5 Gambar Cursor Mouse. 

IV.1.4. Tombol Mulai 

Pada panel Timeline buatlah layer baru dan berikan nama tombol, seret 

button untuk tombol mulai pada panel Library ke panggung layer tombol dengan 

cara pilih menu Window>Common libraries>buttons, lakukan penempatan pada 

tombol dan letakkan diposisi sebelah kiri bawah dari objek gambar. Adapun 

gambar tombol mulai tersebut dapat dilihat pada gambar IV.6 dibawah ini : 
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Gambar IV.6. Tombol Mulai. 

IV.1.5. Tombol Petunjuk  

Di panel Timeline klik layer tombol untuk mengaktifkannya dan penulis 

akan menempatkan tombol petunjuk di layer ini. Lakukan dengan cara pilih menu 

Window>common libraries>button dan seret button yang diinginkan di panel 

library. Klik tombol petunjuk lalu pilih modify>convert to symbol atau F8 berikan 

name mc bantuan dan type movie clip. Klik double tombol petunjuk di layer 

petunjuk, buat layer baru. Klik frame 2 layer 2 lakukan Import objek yang dibuat 

dari CorelDraw X5 untuk dijadikan latar petunjuk. 

Di panel Timeline klik frame 2 layer petunjuk lalu klik kanan Insert 

Keyframe. Hapus action yang ikut dari frame 1 layer petunjuk, pilih tombol 

petunjuk lakukan pengaturan pada color effect>style>tint berikan nilai 50% 

dengan warna biru. Buat tombol untuk kembali kep permainan, misalkan pada text 

static ketik “X” dibawah latar petunjuk pilih modify>convert to symbol berikan 

name mc xx type button. Adapun gambar tombol petunjuk tersebut dapat dilihat 

pada gambar IV.7 dibawah ini : 
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Gambar IV.7 Tombol Petunjuk 

IV.1.6. Tombol Berhenti  

 Di panel Timeline klik layer tombol untuk mengaktifkannya dan penulis 

akan mendapatkan tombol petunjuk di layer ini. Lakukan dengan cara pilih menu 

Window>common libraries>button dan seret button yang diinginkan di panel 

library. Klik tombol berhenti lalu pilih modify>convert to symbol berikan name 

mc_berhenti dan type movie clip. Di panel Timeline klik frame 1 layer berhenti 

lalu klik kanan Insert Keyframe, lakukan pengaturan pada color effect>style>tint 

berikan nilai 50% dengan warna biru. Import objek yang dibuat dari CorelDraw 

X4 untuk dijadikan latar berhenti, buat 2 buah tombol untuk “Ya” dan “Tidak”. 

Adapun gambar tombol berhenti tersebut dapat dilihat pada gambar IV.8 dibawah 

ini : 
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Gambar IV.8 Tombol Berhenti 

IV.1.7. Tombol Musik   

 Di panel Timeline klik layer tombol untuk mengaktifkannya dan penulis 

akan mendapatkan tombol petunjuk di layer ini. Lakukan dengan cara pilih menu 

Window>common libraries>button dan seret button yang diinginkan di panel 

library. Klik tombol berhenti lalu pilih modify>convert to symbol berikan name 

mc_musik2 dan type movie clip. Klik double tombol musik di layer musik, klik 

frame 1layer musik, pada sound di panel properties berikan name musik. Adapun 

gambar tombol musik tersebut dapat dilihat pada gambar IV.9 dibawah ini : 

                                                        

Gambar IV.9 Tombol Musik. 

IV.1.7. Tombol Pause dan Lanjut  

Tombol ini melakukan width 76,15 dan height 26 dengan intance name 

btn_jeda, jadikan tombol tersebut sebagai movie clip dengan pilih Button 

pause>Modify>Convert to Symbol dan berikan name mc_jeda dengan type movie 

clip. Klik frame 2 layer pause klik button pause pilih swap pada panel properties 

seret button lanjut dan letakkan diatas button pause. 
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 Tetap di frame 2 lakukan import to stage untuk menerapkan latar 

informasi. Buat layer baru dengan nama action letakkan posisinya diatas layer 

pesan. Adapun gambar tombol pause dan lanjut tersebut dapat dilihat pada gambar 

IV.10 dibawah ini : 

 

Gambar IV.10 Tombol Pause dan Lanjut 

IV.1.9. Objek Tanda Beda Lingkaran 

Di panel Timeline buat layer baru dengan nama permainan. Pada tool box 

pilih oval tool dan buat lingkaran dengan ukuran width 18,50 dan height 18,50. 

Pilih warna fill dengan alpha 35%. Klik kanan objek oval pilih menu 

modify>convert to symbol berikan name beda dan type movie clip, lakukan 

duplikat pada frame 1 dan letakkan pada frame 2. Kemudian group objek oval dan 

lakukan duplikat sebanyak 5,10 dan 15 pada masing- masing level tertentu. Pilih 

objek oval berikan instance name beda1 sampai dengan beda5, beda10 dan 

beda15 pada masing- masing level. Adapun gambar objek tanda beda lingkaran 

tersebut dapat dilihat pada gambar IV.11 dibawah ini : 

 

Gambar IV.11 Objek Tanda Beda Lingkaran 
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IV.1.10. Teks Indikator 

Buat teks dengan static text dan tuliskan dengan “Cari” dan “Perbedaan 

Lagi” letakkan dengan posisi yang sama dan berikan jarak untuk diletakkan 

dynamic text. Buat kembali teks dengan dynamic text berikan ukuran font 20, 

dengan karakter font courier new pilih warna putih untuk teks static dan warna 

biru untuk dynamic text. Pilih teks dynamic text berikan nama variable di panel 

properties dengan nama hasil. Adapun gambar teks indikator tersebut dapat 

dilihat pada gambar IV.12 dibawah ini : 

 

Gambar IV.12. Teks Indikator. 

IV.1.11. Halaman Menang 

Di panel Timeline buat layer baru dengan nama layer pesan atur posisi 

diatas layer button. Di frame 2 layer pesan buat teks “Horrree... Anda 

Menang!!!” dengan menggunakan text tool pada static text dan berikan warna 

ungu. Adapun gambar halaman menang level 1 tersebut dapat dilihat pada gambar 

IV.13 dibawah ini : 

 

Gambar IV.13 Halaman Menang Level 1. 



 
 

63 

  Pada scene 3 di panel Timeline buat layer baru dengan nama layer pesan 

atur posisi diatas layer button. Di frame 2 layer pesan buat teks “Horrree... Anda 

Menang!!!” dengan menggunakan text tool pada static text. Adapun gambar 

halaman menang level 2 tersebut dapat dilihat pada gambar IV.14 dibawah ini : 

 

Gambar IV.14 Halaman Menang Level 2. 

             Pada scene 5 di panel Timeline buat layer baru dengan nama layer 

pesan atur posisi diatas layer button. Di frame 2 layer pesan buat teks “Horrree... 

Anda Menang!!! The End” dengan menggunakan text tool pada static text. 

Adapun gambar halaman menang level 3 tersebut dapat dilihat pada gambar IV.15 

dibawah ini : 

 

Gambar IV.15 Halaman Menang Level 3. 
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IV.1.12. Halaman Kalah 

Di panel Timeline scene 1 layer pesan pada frame 3 buat teks “Huuu... 

Anda Kalah!!!” dengan menggunakan text tool pada static text dan berikan 

warna ungu. Adapun gambar halaman kalah level 1 tersebut dapat dilihat pada 

gambar IV.16 dibawah ini : 

 

Gambar IV.16 Halaman Kalah Level 1 

Di panel Timeline scene 3 layer pesan pada frame 3 buat teks “Huuu... 

Anda Kalah!!!” dengan menggunakan text tool pada static text dan berikan 

warna ungu. Adapun gambar halaman kalah level 2 tersebut dapat dilihat pada 

gambar IV.17 dibawah ini : 

  

 

Gambar IV.17 Halaman Kalah Level 2 



 
 

65 

 Di panel Timeline scene 5 layer pesan, klik pada frame 3 layer pesan buat 

teks “Huuu... anda Kalah!!!” dengan menggunakan text tool pada static text. 

Buat layer baru kembali dan letakkan diatas layer pesan dengan nama action. 

Buat kembali layer baru dengan nama label dan berikan instance name pada 

properties di frame 1 dengan name frame_level 1, di frame 2  berikan dengan 

name frame_menang1 dan di frame 3 berikan dengan name frame_kalah1. 

Adapun gambar halaman kalah level 3 tersebut dapat dilihat pada gambar IV.18 

dibawah ini : 

 

Gambar IV.18 Halaman Kalah Level 3 

IV.1.13. Tombol Main Lagi 

Di panel Timeline pilih layer pesan, klik pada frame 3 layer pesan lalu 

seret tombol dari Window>common libraries>buttons jadikan button menjadi 

action movie clip. Kemudian klik frame 2 di dalam mc musik lakukan klik kanan 

Insert Keyframe. Adapun gambar tombol main lagi tersebut dapat dilihat pada 

gambar IV.19 dibawah ini : 

 
Gambar IV.19 Tombol Main Lagi 

IV.1.14. Publish Game 
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 Selanjutnya penulis akan melengkapi dengan membuat aplikasi proyek 

game mencari perbedaan rumah agar dapat dibuka disetiap Personal Computer. 

1. Simpan dokumen proyek tersebut terlebih dahulu. 

2. Klik menu File>Publishing Setting sehingga akan tampil kotak dialog 

Publishing Setting. 

 

Gambar IV.20. Publishing Game 

3. Dalam kotak dialog, tandai kotak Windows Projektor lalu klik tombol 

publish. 

4. Tutup kotak dialog dengan mengklik tombol OK 

 

IV.2. Pembahasan  

 Dalam pembuatan game Mencari perbedaan Rumah dengan menggunakan 

objek- objek serta fitur- fitur untuk melengkapi game. Pada proyek game ini 

desain permainan berbasis objek 2D. 
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 Adapun penjelasan dari beberapa fitur pelengkap game tersebut yaitu 

tombol mulai yang berfungsi sebagai awal dimulainya game dengan waktu 

mundur, tombol petunjuk yang berfungsi sebagai penjelasan dari permainan, 

tombol berhenti yang berfungsi sebagai intruksi dalam mengakhiri permainan, 

tombol musik yang berfungsi sebagai mengaktifkan dan menonaktifkan musik 

dalam bermain, tombil pause yang berfungsi sebagai berhenti sejenak dalam 

bermain, tombol lanjut yang berfungsi untuk melanjutkan game yang dihentikan 

sejenak ketika tombol pause diaktifkan, tombol main lagi berfungsi sebagai 

mengulang game yang tidak dapat diselesaikan oleh pemain dalam waktu yang 

ada sehingga tombol main lagi dipilih untuk dapat memainkan dan menyelesaikan 

permainan agar dapat melanjutkan ke level berikutnya, tombol level 2 dan level 3 

berfungsi untuk melanjutkan ke level 2 dan level 3 jika di level 1 dan level 2 

berhasil menyelesaikan permainan. 

 Game mencari perbedaan rumah ini dimainkan hanya untuk single player 

dengan cara memainkannya yaitu pemain mencari potongan objek rumah yang 

berbeda pada tampilan 2 gambar yang disediakan, jika ditemukan perbedaannya 

lakukan klik pada pointer mouse ke arah gambar yang disebelah kiri dari pemain. 

Game ini memiliki sampai 3 level, tiap level memiliki batasan waktu yang 

berbeda, pada level 1 waktu diberikan 3 menit, level 2 waktu diberikan 2 menit 

dan level 3 waktu diberikan 1 menit. Pemain harus bisa menyelesaikan game 

ditiap level agar dapat melanjutkan ke game berikutnya. 

 Dari uraian diatas maka dapat ditarik kesimpulan, game mencari 

perbedaan rumah ini merupakn game edukasi yang berbasis flash dengan desain 
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gambar yang memiliki panduan warna yang cerah dan segar sehingga suasana 

game ini jauh lebih hidup dan menarik dilihat serta game ini dilengkapi fitur- fitur 

yang diterapkan pada game. 

 

IV.3. Kelebihan dan Kekurangan Sistem yang Dirancang 

 Adapun kelebihan dan kekurangan dari sistem yang dirancang pada Game 

Mencari Perbedaan Rumah adalah sebagai berikut : 

1. Kelebihan  

a. Game mencari perbedaan rumah ini berbasis flash dan desain yang 

menarik pada panduan warna yang diberikan sehingga lebih hidup dan 

menarik. 

b. Tersedianya fitur- fitur pelengkap pada game.  

c. Objek yang dibuat telah diterapkan kedalam ActionScript 2.0 seperti 

frame, movie clip, button dan sound. 

d. Game mencari perbedaan rumah ini dapat menjadi game edukasi dalam 

meningkatkan ketangkasan. 

2. Kekurangan 

a. Game ini hanya dapat dimainkan oleh satu pemain (single player). 

b. Tampilan Objek game masih 2D. 

c. Game ini hanya memiliki sampai 3 level. 

d. Cara memainkannya masih menggunakan pointer mouse. 

e. Tidak tersedianya fitur penyimpanan data skore pada game. 
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f. Tidak tersedianya fitur fullscreen dan restore untuk tampilan size pada 

game. 

g. Bahasa program masih menggunakan ActionScript 2.0 sehingga sedikit 

lebih lama dalam eksekusi program. 


